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Eureka Landfill, NW.T.

EXECUTIVE SUMMARY

A detailed site characterization and the installation of a monitoring system was conducted
at the main abandoned landfill at the Eureka High Arctic Weather Station on September

7 and 8, 1995.

Preliminary site characterization, conducted by Environmental Services staff in 1994,
showed hydrocarbon and targeted inorganic compounds had concentrations that exceeded
the federal assessment criteria. Based on the preliminary sampling results, the observed
exposed drums and the HAZMAT (batteries, containers of hazardous materials, etc.) it was
recommended to conduct a detailed site characterization to determine the concentration

and extent of the contamination.

The environmental concerns are that: contaminants leaching from the landfill contents may
be entering Slidre Fiord and present a Fisheries Act violation; and landfill capping material
may not freeze back to form a permafrost layer rendering contents and landfill cover

unstable.

In the early summer of 1995, Environment Canada Staff at Eureka in conjunction with
National Defence staff initiated a capping operation of the landfill. Large sections of
potentially contaminated soils have been scrapped from the landfill drainage area and
used as capping material. Work has not been completed and several exposed sections
of debris remain visible. The resulting slope of the landfill face exceeds the angle of

repose for the local soil conditions and is unstable.

The detailed soil sampling program shows that at present there has not been off-site
migration of contaminants.

A temperature sensor monitoring system was installed at a stable location through one (1)
metre of capping depth. The system is designed to monitor freezeback in the landfill cap.
Monitoring freezeback is essential for confirming landfill environmental and structural
stability, as well as to confirm the suitability of the design cap thickness.

It is recommended that completion of the landfill closure be properly engineered to prevent
both structural and environmental failure.

i Environmental Services, PW&GSC
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Eureka Landfill, NW.T.

1.0 INTRODUCTION

Eureka, established on April 7, 1947, was the first Joint Arctic Weather Station operated
cooperatively by the Canadian and American Governments. In 1972, the American
participation ended and was renamed the Eureka High Arctic Weather Station (HAWS).

Eureka is approximately 1100 Km from the true North Pole and is located on Fosheim
Peninsula, on the northern shore of Slidre Fiord (Figures 1 and 2). Eureka's coordinates
are, 79°59'41" N and 85°48'48" W. The duration of the light season is between April 14
and October 21. Annual precipitation, mostly in the form of snow, is approximately 6.8 cm.

In November, 1994 a preliminary site characterization of the main abandonned landfill was
conducted by Environmental Services, PW&GSC staff. Thirteen (13) samples were taken
in and around the landfill site and analyzed for hydrocarbon parameters and targeted
inorganic and heavy metal compounds. Assessment criteria, which determines the
presence of contamination, were exceeded in two (2) samples for hydrocarbons and
exceeded in five (5) samples for heavy metals (boron, chromium, cobalt, lead,
molybdenum, nickel, and zinc). In addition, large numbers of 45 gallon drums and other
hazardous materials (batteries, fuel tanks, containers of glycol, and others) were observed
exposed to the environment.

It was recommended from the preliminary site characterization that a detailed
characterization be conducted to delineate the concentration and extent of contamination
that exists around the landfill. It was also recommended that proper closure of the landfill
be carried out including removal of all 45 gallon drums and other point sources of
contamination and the placement of properly sloped capping to prevent further leaching
of contaminants. Finally, it was suspected that the background sample taken during the
preliminary site characterization was from a highly disturbed area, therefore, it was
recommended that further background sampes be taken to adequately evaluate the
contribution of point source contamination.

In the early summer of 1995, under the direction of the Environment Canada Officer in
Charge and with the cooperation of National Defence, capping of the landfill was initiated
though not completed.

1 Environmental Services, PW&GSC
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Eureka Landfill, NW.T.

2.0 ENVIRONMENTAL SETTING

The annual precipitation in the Eureka area is very low at 6.8 cm. It primarily occurs as
snow and can fall any time of the year. The main off-site drainage occurs seasonally in
the spring in late May and early June. The landfill site drains by a 1500 m channel and
a 60 m relief to Slidre Fiord.

The depth of the permafrost layer of the Eureka area is between 0.15to 0.5 m. Soils in
the active layer are composed of mainly sands (18%), silts (47%),and clays (35%) and is
representative of soils commonly found in the high Arctic tundra.

Wildlife observed in the Ellesmere Island area include, Arctic wolf, Arctic fox, caribou,
muskox, Arctic hare, polar bear, ermine, beluga, narwhal, walrus, ringed seal, waterfowl,
seabirds, and raptors. The landfill site in particular was observed to attract scavenging
Arctic wolves and occasionally muskox.

The major plant varieties include lichens, cotton grass, sedges, and grasses and represent
the major food source for the herbivores.

3.0 OBJECTIVES

The following are the three objectives of the investigation:

31  To conduct a detailed site characterization to delineate the nature and extent of the
contamination plume identified in the preliminary site characterization;

3.2 Todetermine a baseline contamination concentrations in the landfill drainage area;

3.3 To provide a program for monitoring the performance of the landfill capping and
containment structure. '

3 Environmental Services, PW&GSC
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SCOPE OF WORK

Background:

Review of background documentation including the Preliminary Site
Characterization of an Abandonned Landfill, Eureka, NW.T., as well as, files,
drawings, aerial survey maps.

Discussion with key personnel familiar with the site.

Field Program:

Conduct a detailed sampling of soils and sediments to delineate the nature and
extent of contamination previously identified to determine whether concentrations

are exceeding criteria.

Install a capping freeze-back monitoring system for the long-range assessment of
the landfill capping and containment performance.

Analysis of Soil and Sediment Samples:

Samples are to be performed by a member of the Canadian Association for
Environmental Analytical Laboratories (CAEAL): Norwest Labs 9936-67 Avenue,

Edmonton, Alberta, T6E OP5, (403) 438-5522.

Delineation and remediation criteria is the DEW Line Cleanup Criteria (DCC).
Remediation is to be applied to soils and sediments where inorganic elements
and/or PCBs have been found to be present at concentrations in excess of the

DCC.
Documentation:

Preparation of the draft document detailing sampling results, conclusions, and
recommendations.

Document review by Environment Canada (AES) staff.

Preparation and delivery of final documentation (3 copies).

4 Environmental Services, PW&GSC



Eureka Landfill, NW.T.

5.0 CRITERIA

The DEW Line Clean Up Protocol (DCLU), of which the DCC is a component of, provides
a strategy for dealing with chemical contamination and physical debris at DEW Line sites.
The DCLU was originally endorsed by various government agencies including
Environment Canada, Indian and Northern Affairs Canada, Government of the Northwest
Territories and the Department of Fisheries and Oceans in 1991 and revised in 1994. The
DCC are a combination of the CCME R/P' and the Quebec B? criteria and were
determined. on the basis of site specific risk assessments, to be protctive of the Arctic

ecosystem.

As a result of similar operations and environmental settings, the DEW Line Cleanup
Criteria is considered an appropriate standard for remediation of soils and sediments.

Although not necessarily limited to, standards which may be employed include the
following:

. Interim Canadian Environmental Quality Criteria for Contaminated Sites,
CCME, 1991.
. Environmental Guidelines for Site Remediation, Northwest Territories

Renewable Resources, 1994.

. Guidelines for the Planning, Design, Operation and Maintenance of Solid
Waste Modified Landfill Sites in the Northwest Territories, GNWT, 1990.

. DEW Line Cleanup Criteria, ESG, 1994.
. Guidelines for Contaminated Site Remediation, G.N.W.T., 1993.

. Guidance Manual on Sampling, Analysis, and Data Management for
Contaminated Sites, CCME, 1993.

1 Interim Canadian Environmental Quality Criteria for Contaminated Sites for the
Canadian Council for the Ministers of the Environment (CCME:1991).

2 Quebec Soil Contamination Guidelines (GoQ:1991).

5 Environmental Services, PW&GSC



Eureka Landfill, NW.T.

. Technical Assistance Bulletin on Contaminated Sites #4 - Sampling and
Analysis of Hydrocarbon Contaminated soil, Environment Canada, 1992.

. Subsurface Assessment Handbook for Contaminated Sites, CCME, 1994,

. Canadian Environmental Protection Act.
. Fisheries Act.
. Canad‘ian Environmental Assessment Act, 1992.

6.0 SAMPLING METHODOLOGY & SOILS INVESTIGATION

Targeted compounds follow closely the analytical parameters specified in the DEW Line
Cleanup Criteria. These include Arsenic, Cadmium, Chromium, Cobalt, Copper, Lead,
Mercury, Nickel, Zinc, and PCBs.

In keeping with the risk assessments conducted for the DEW Line sites, gross
hydrocarbon parameters were not targeted.

The detailed sampling was conducted by Michael Nahir of Environmental Services,
PW&GSC. Two (2) background soil samples were taken on May 26, 1995. Twenty five
(25) soil and sediment samples were taken on September 8, 1995.

The two background samples were taken approximately 1 km east of the runways east end
well away from the landfill. The location was chosen from aerial photos prior to the field
visit and selected based on visible non-impacted areas. Background samples were taken
close to vegetation in nonimpacted areas.

Twenty (20) samples were taken in the immediate area of the landfill along the perimeter
and somewhat further downgradient at regular intervals covering the complete drainage
zone. Five (5) soil/sediment samples were taken along the drainage channel leading
southwest of the landfill and into Slidre Fiord.

Sampling locations were chosen in small drainage channels, in low spots, at channel
bends, and in other locations likely to contain migrating contaminants.

6 Environmental Services, PW&GSC



Eureka Landfill, NW.T.

Sampling involved using an Arctic sampling tool composed of a bevelled edge cylinder and
a piston/plunger assembly for sample extraction. Column core samples were taken to just
above the permafrost layer so as to capture the "floating" contaminant. The samplers were
washed with water and paper towel, rinsed with acetone, and again rinsed with water and

dried.

Samples were placed in 100 ml wide mouthed precleaned jars, filled to the top (to reduce
headspace), and capped with Teflon lined lids. Each sample was labelled and placed in
an ice packed coolers. All sample jars were supplied by Norwest Labs in Edmonton and
arrived in sealed cartons. All samples were delivered by Michael Nahir to Norwest Labs,
9938-67 Avenue, Edmonton, Alberta on September 11, 1995. Norwest Labs is a member
of Canadian Association for Environmental Analytical Laboratories.

The sampling strategy involved taking (twenty) 20 grid samples along the bottom of the
landfill and extended outwards in the main drainage area down gradient of the working
face (see Figure 3). Five (5) sediment/soil samples were taken along the drainage
channel upslope of Slidre Fiord. The samples were located to define the extents and
variations in the concentrations of the targeted contaminants. Remedial actions are based

on the results of these findings.

No water samples were taken as there was no run-off on site at the time of sampling.

7.0 RESULTS

Analytical results for twenty five (25) soil and sediment samples are shown in Table 1.
Sampling locations are shown in Drawing 1. Results are compared to the DEW Line
Cleanup Criteria and the average value of the background samples. Since PCBs are not
a naturally occurring compound in the environment, background samples were not
analyzed for PCBs.

It was observed that there were several sections of the landfill exposed and left uncapped.
Small quantities of waste debris remain outside the immediate landfill area.

The landfill slope with the present capping system significantly exceeds the location's
natural angle of repose and is therefore unstable.

7 Environmental Services, PW&GSC



Eureka Landfill, NW.T.

Table 1 Soil and Sediment Sampling Analysis of Landfill Drainage Area

DEW Line Back-
Cleanup ground Soil Sample
Criteria
(ppm) (ppm) (ppm)
Parameter | Tier1 | Tier2 | AVG. 1 2 3 4 5

PCBs l 200 <0.1 <0.1 <0.1 <0.1 <0.1

As 30 8.30 6.68 6.80 6.95 6.69 6.35

Ba
Be
Cd
Cr
Co

44.8 104 93.7 941 99.6 772
0.3 1.17 1.02 1.08 1.15 | 0.792

5.0 <0.3 0.142 | 0.119 | 0.179 | 0.121 | 0.161
250 15.5 33.7 248 421 33.2 244

50 55 12.6 12.6 12.6 13.1 9.98

<2 0.20 0.30 0.65 0.22 0.26
100 14 291 28.4 36.0 30.6 249

<5 1.1 0.98 1.04 1.01 0.81
26.7 40.6 38.0 38.6 39.4 28.5
500 35.6 71.0 73.3 69.2 69.8 96.5

Ti
\'}
Zn

|
|
|
I
l
i
Cu 100 9.5 26.8 26.2 248 28.0 19.7
Hg 2.0 0.03 0.06 0.06 0.06 0.06 0.06
Pb 200 500 3 11.2 11.6 1.6 10.9 11.0
Mo
Ni
Se 0.07 2.61 2.70 2.41 2.71 1.92
|

8 Environmental Services, PW&GSC



Eureka Landfill, N.W.T.

Table 1 Soil and Sediment Sampling Analysis of Landfill Drainage Area (Cont'd)

DEW Line Back-
Cleanup ground Soil Sample
Criteria
(ppm) (ppm) || (ppm)

Parameter || Tier 1 l Tier 2

PCBs <0.1 <0.1 <0.1 <0.1 <0.1
As ] 6.89 | 074 | 7.08 | 627 | 630
Ba l 104 93.7 941 996 | 77.2
Be I 1.17 1.02 1.08 1.15 | 0.792
Cd J 0.142 | 0.119 | 0.179 | 0.121 | 0.161
Cr J 337 24.8 421 332 | 244
Co ] 12.6 12.6 12.6 13.1 9.98
Cu I 26.8 26.2 248 | 28.0 | 197
Hg J 20 0.03 0.06 0.06 0.06 0.05 0.05
Pb 200 500 3 10.2 1.8 11.0 9.7 9.6
Mo <2 030 | <0.05 | 022 | 024 | 0.022
Ni l 100 14 27.6 3.42 289 | 248 | 263
Se 0.07 215 | <0.15 | 254 | 210 | 225
Ti J <5 0.67 0.41 106 { 0.74 | 0.73
Vv I 26.7 33.1 4.45 410 | 37.7 | 36.2
Zn J 500 35.6 67.9 10.2 736 | 656 | 63.2

9 Environmental Services, PW&GSC



Eureka Landfill, NW.T.

Table 1 Soil and Sediment Sampling Analysis of Landfill Drainage Area (Cont'd)

DEW Line Back-

Cleanup ground Soil Sample
Criteria
(ppm) (ppm) -_(ppm)
Parameter || Tier1 | Tier2 | AVG. 11 12 13 14 15
= == e
PCBs 200 . <0.1 <0.1 <0.1 <0.1 <0.1
As 30 8.30 0.62 6.46 6.48 069 | 0862
448 10.0 79.8 108 9.33 9.59
Be 0.3 0.132 | 0.913 | 0.925 | 0.116 | 0.119

Cd 5.0 <0.3 || <0.025| 0.172 | 0.228 | <0.025| 0.036

l 1.0
Cr 250 16.5 3.83 29.7 24.9 3.01 2.95
Co 50 55 1.50 11.4 11.5 1.40 1.52
Cu 100 9.5 2.73 21.8 226 | 2.54 2.65
200

|
Ba J
|
|
|
|

Hg 2.0 0.03 0.06 0.06 0.05 | 0.05 | 0.06
Pb 500 3 1.5 11.6 254 1.4 1.3

Mo <2 <0.05| 028 0.22 | <0.05} <0.05
Ni 100 14 3.39 285 256 | 3.01 3.33
Se 0.07 0.27 1.96 218 | 0.21 0.22
Ti <5 <0.20 | 068 0.79 | <0.20| 0.31

Vv } 26.7 4.27 32.7 340 | 419 | 4.16
Zn ] 500 35.6 9.03 70.0 655 | 817 8.25

10 Environmental Services, PW&GSC



Eureka Landfill, NW.T.

Table 1 Soil and Sediment Sampling Analysis of Landfill Drainage Area (Cont'd)

DEW Line Back-
Cleanup ground Soil Sample
Criteria '
(ppm) (ppm) (ppm)
Parameter || Tier1 | Tier 2| AVG. 16 17 18 19 20

e _____T_____
1 200 <0.1 <0.1 <0.1 <0.1 <0.1
30 8.30 7.07 6.55 7.27 6.27 6.85
448 63.2 90.0 82.4 956 92.7

0.3 0.718 1.02 | 0.974 | 0.98 1.12

5 <0.3 | <0.025| 0.172 | 0.228 | <0.025| 0.036

250 15.5 3.83 29.7 249 3.01 2.95

50 5.5 1.50 11.4 11.5 1.40 1.52

100 9.5 273 21.8 22.6 2.54 2.65

2 0.03 0.06 0.06 0.06 0.05 0.06

200 500 3 10.2 9.8 10.7 14.4 10.7
<2 0.24 0.25 0.23 0.18 0.17

100 14 20.1 27.2 26.3 25.9 30.5

0.07 1.69 2.27 2.47 2.22 2.33
<5 0.40 0.79 0.75 0.80 0.90
26.7 253 359 36.2 37.3 38.4
500 35.6 50.9 63.9 68.6 69.8 70.7

11 Environmental Services, PW&GSC



Eureka Landfill, NW.T.

Table 1 Soil and Sediment Sampling Analysis of Landfill Drainage Area (Cont'd)
DEW Line Back-
Cleanup ground Soil Sample
Criteria
(ppm) (ppm) (ppm)
Parameter | Tier1 | Tier2| AVG. 21 22 23 24 25
PCBs l 1.0 200 <0.1 <0.1 <0.1 <0.1 <0.1
As J 30 8.30 6.49 6.63 954 | 425 577
Ba 44.8 85.7 83.9 959 | 353 | 46.0
Be [ 0.3 0.907 | 0.924 | 0488 | 0.397 | 0.591
Cd ‘ 5.0 <0.3 0.302 | 0.133 | 0.089 | 0.070 | 0.088
Cr J 250 15.5 25.7 281 13.7 12.4 17.4
Co I 50 55 11.4 10.8 6.46 | 577 7.34
Cu 100 9.5 22.4 20.8 10.9 | 885 13.4
Hg 2.0 0.03 0.05 0.05 0.04 | 0.02 0.04
Pb r200 500 3 20.0 10.5 6.4 50 6.4
Mo J <2 0.29 0.20 039 | 026 | 0.23
Ni 100 14 24.7 251 16.5 12.3 17.0
Se 0.07 2.27 2.17 2.00 1.05 1.34
Ti <5 0.65 0.63 0.83 | 0.27 0.30
Vv [ 26.7 33.1 | 338 20.6 17.7 | 224
Zn J r 500 356 77.9 64.3 36.1 300 | 37.5
12 Environmental Services, PW&GSC




Eureka Landfill, NW.T.

8.0 MONITORING

In the program for decommissioning of the first DEW Line site, determination of landfill
capping freeze-back was identified as an effective monitoring objective. Detection of
freeze-back provides an indication of landfill stability and suitability of the capping
thickness. By measuring temperature in the active zone you can determine the dynamic
freeze-thaw cycle. Often, sources of contamination produce significant amounts of heat as
a result of biological decay of waste. This heat can modify the freeze-thaw cycle in the

active zone.

The temperature sensor system is composed of three (3) Stowaway dataloggers by Onset
Cormnputer Corporation placed at 0.5 m depth intervals in a 1.5 m long and 3 inch diameter
vertically placed and backfilled PVC standpipe. Readings should be taken twice a year to
prevent loss of temperature information. Data is to be downloaded onto PC system (laptop)
from each of three sensors placed at the three depths. Windows compatible datalogger
software and instruction is attached as an Annex.

The sensor system was placed in a relatively stable location of the landfill. The location
had a 1m capping thickness and was only moderately sloped. The datalogger depths were
chosen to reflect a complete temperature profile across the capping thickness. The sensor
location and detail is shown in Drawing 1. Monitoring temperature sensor details are listed

in Table 2.

Table 2 Temperature Monitoring Sensors
Stowaway | Label No. Depth Monitoring| Measurement Start of
Unit S/N Below Duration Frequency Charging

Grade (m) (days) hr-min) (Date, Time)
5038 EU-A0 0 360 4-48 9.8.95-09:0
5037 EU-A,0.5 0.5 360 4-48 9.8.95-09:00“
5040 EU-A,1.0 1 360 4-48 9.8.95-09:00“
13 Environmental Services, PW&GSC



Eureka Landfill, NW.T.

9.0 CONCLUSIONS AND RECOMMENDATIONS

Landfill coverage has been partially completed with some sections exposed. Much of the
drainage soils have been disturbed and used as capping material. Landfill slope is greater
than angle of repose and is therefore unstable. Landfill drainage is by channel/stream into

Slidre Fiord.

Soil sampling in landfill drainage area showed no off-site migration of contamination. A
further five downstream sediment/soil samples did not show off-site contamination. This
is expected as a result of the soils removed from the drainage area during this summers
initial capping operation. This likely includes the soils which showed high contaminant
levels as indicated in the Preliminary Site Characterization conducted by Environmental
Services on June 2, 1994. Since the analytical results indicate that no contamination has
been transported through the active layer (above permafrost), any existing contaminanted
soils are presently within the capping system. In order to prevent possible migration of
these contaminants, it is recommended that the landfill be properly capped and sloped.

Detection and analysis criteria used at the Eureka Landfill is consistent with the clean-up
of northern DEW Line sites.

It is recommended that completion of landfill closure be properly engineered to prevent both
structural and environmental failure of existing partially capped system. The previous work
in the partial decommissioning of the landfill was not supervised by trained staff and, as a
result, possesses potential liabilities.

On-going monitoring of capping freezeback assists in detecting landfill stability as well as
verifying capping thickness. Readings should be taken twice a year to prevent loss of
temperature information. Monitoring should continue until the stability off the permafrost
layer can be ensured within the capping system.

14 Environmental Services, PW&GSC
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PHOTOGRAPHS




Photo #1: Landfill Prior to Partial Capping, North, May 1995
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Photo #2: Landfill Prior to Partial Capping, South, May 1995
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Photo #4:

Landfill After Partial Capping, South, September 1995




Photo #6:

Sampling Program (note Scraped Drainage), North, Sep.1995




Photo #8: Sampling Drainage Channel, North, Sep.1995
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Photo #9: Temperature Monitoring Sensors, South, Sep.1995

Photo #10: Temperature Monitoring Sensors, South, Sep.1995
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1000, 9700 JASPER AVE EUREKA LANDFILL
EDMONTON, AB 09 09 95
T5J 4E2

ICP TRACE, 3050= ==================== =====================

I PUBLIC WORKS CANADA MICHAEL NAHIR

EPA 3050
EPA3050 EPA3050 EPA3050 EPA3050 EPA3050 EPA3050
As Ba Be cd Cr Co Cu
I ________ SAMPLE DESCRIPTION = mg/kg mg/kg mg/kg mg/kg mg/kg mg/kg mg/kg
1 EU-1 6.68 104 1.17 0.142 33.7 12.6 26.8
2 EU-2 6.80 93.7 1.02 0.119 24.8 12.6 26.2
I 3 EU-3 6.95 94.1 1.08 0.179 42.1 12.6 24.8
4 EU-4 6.69 99.6 1.15 0.121 33.2 13.1 28.0
5 EU-5 6.35 77.2 0.792 0.161 24.4 9.98 19.7
l 6 EU-6 6.89 77.1 0.886 0.116 24.3 11.1 21.2
7 EU-7 0.74 10.4 0.140 < 0.025 4.10 1.53 2.89
8 EU-8 7.08 108 1.15 0.236 31.4 12.9 25.8
l 9 EU-9 6.27 88.4 0.973 0.169 26.1 11.5 22.4
10 EU-10 6.30 87.1 1.00 0.136 28.7 11.9 22.6
11 EU-11 0.62 10.0 0.132 < 0.025 3.83 1.50 2.73
12 EU-12 6.46 79.8 0.913 0.172 29.7 11.4 21.8
l 13 EU-13 6.48 108 0.925 0.228 24.9 11.5 22.6
) 14 EU-14 0.69 9.33 0.116 < 0.025 3.01 1.40 2.54
15 EU-15 0.62 9.59 0.119 0.036 2.95 1.52 2.65
I 16 EU-16 7.07 63.2 0.718 0.091 20.1 8.57 17.6
17 EU-17 6.55 90.0 1.02 0.141 28.7 12.1 23.4
18 EU-18 7.27 82.4 0.974 0.148 22.4 12.0 24.9
I 19 EU-19 6.27 95.6 0.985 0.195 29.0 11.3 - 22.7
20 EU-20 6.85 92.7 1.12 0.144 30.9 12.8 25.7
21 EU-21 6.49 85.7 0.907 0.302 25.7 11.4 22.4
22 EU-22 6.63 83.9 0.924 0.133 28.1 10.8 20.8
l 23 EU-23 9.54 35.9 0.488 0.089 13.7 6.46 10.9
24 EU-24 4.25 35.3 0.397 0.070 12.4 5.77 8.85
I 25 EU-25 5.77 46.0 0.591 0.088 17.4 7.34 13.4
I Lab Manager: 15//’ ZC
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l PUBLIC WORKS CANADA MICHAEL NAHIR

ICP TRACE, 3050= ====s==================—=z=====================
EPA3050 EPA3050 EPA3050 EPA3050 EPA3050 EPA3050 EPA3050

Pb Mo Ni Se T1 v Zn

l ________SAMPLE DESCRIPTION mg/kg mg/kg mg/kg mg/kg mg/kg mg/kg mg/kg
1 EU-1 11.2 0.20 29.1 2.61 1.11 40.6 71.0
2 EU-2 11.6 0.30 28.4 2.70 0.98 38.0 73.3
3 EU-3 11.6 0.65 36.0 2.41 1.04 38.6 69.2
4 EU-4 10.9 0.22 30.6 2.71 1.01 39.4 69.8
5 EU-5 11.0 0.26 24.9 1.92 0.81 28.5 96.5
6 EU-6 10.2 0.30 27.6 2.15 0.67 33.1 67.9
7 EU-7 1.8 < 0.05 3.42 < 0.15 0.41 4.45 10.2
8 EU-8 11.0 6.22 28.9 2.54 1.06 41.0 73.6
9 EU-9 9.7 0.24 24.8 2.10 0.74 37.7 65.6
10 EU-10 9.6 0.22 26.3 2.25 0.73 36.2 63.2
11 EU-11 1.5 < 0.05 3.39 0.27 < 0.20 4.27 9.03
12 EU-12 11.6 0.28 28.5 1.96 0.68 32.7 70.0
13 EU-13 25.4 0.22 25.6 2.18 0.79 34.0 65.5
14 EU-14 1.4 0.05 3.01 0.21 < 0.20 4.19 8.17
15 EU-15 1.3 0.05 3.33 0.22 0.31 4.16 8.25
16 EU-16 10.2 0.24 20.1 1.69 0.40 25.3 50.9
17 EU-17 9.8 0.25 27.2 2.27 0.79 35.9 63.9
18 EU-18 10.7 0.23 26.3 2.47 0.75 36.2 68.6
19 EU-19 14.4 0.18 25.9 2.22 0.80 37.3 69.8
20 EU-20 10.7 0.17 30.5 2.33 0.90 38.4 70.7
21 EU-21 20.0 0.29 24.7 2.27 0.65 33.1 77.9
22 EU-22 10.5 0.20 25.1 2.17 0.63 33.8 64.3
6.4 0.39 16.5 2.00 0.83 20.6 36.1

5.0 0.26 12.3 1.05 0.27 17.7 30.0

25 EU-25 6.4 0.23 17.0 1.34 0.30 22.4 37.5

Lab Manager: // / <
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*note*

l PUBLIC WORKS CANADA MICHAEL NAHIR

09 09 95

SOIL COL

SAMPLE DESCRIPTION mg/kg

l’ EU-1 0.06

MERCURY

0.06
0.06
0.06
0.06
0.06
0.06
0.06
0.05
0.05
0.06
0.06
0.05
0.05
0.06
0.06
0.06
0.06
0.05
0.06
0.05
0.05
0.04
0.02
0.04

DATE 15 SEP 95 14:39
P.0. NO.
w.o.No. 4 103006

PAGE 3

ANALYSIS PERFORMED ON DRIED AND GROUND SAMPLE.DRYING TEMPERATURE NOT

TO EXCEED 60 DEGREES CENTIGRADE AS PER EPA 7471.

ADDITIONAL PKG DSHG,ALL SAMPLES FROM 1 TO 25

Lab Manager: ,/ /(
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EPA3050
'EPA 3050

EPA3050
EPA3050
'EPA3050
EPA3050
EPA3050
EPA3050
EPA3050
EPA3050
EPA3050
33050
a3050
EPA3050
EPA 3050

- Em s .

The following published METHODS OF ANALYSIS were used:

ARSENIC

BARIUM
Acid digestion o€ sediments, soils,and
sludges using nitric acid/hydrogen
peroxide. Reported on dry weight(mg/kg).
Ref. EPA 3050 (SW-846)

BERYLLIUM

CADMIUM

CHROMIUM

COBALT

COPPER

LEAD

MOLYBDENUM

NICKEL

SELENIUM

THALLIUM

VANADIUM

ZINC

TRACE EPA 3050
Acid digestion of sediments, soils,and
sludges using nitric acid/hydrogen
peroxide. Reported on dry weight(mg/kg).
Ref. EPA 3050 (SW-846)

Method References:

1. APHA

w
.

=
12}
n

Standard Methods for the Examination of Water and Wastewater,
American Public Health Assoc., 17th ed.
a. Test Methods for Evaluating Solid Waste, Physical/Chemical
Methods SW-846, 3rd ed., US EPA, 1986
b. Methods for Chemical Analysis of Water and Wastewater, US EPA, 1983 -
Manual on Soil Sampling and Methods of Analysis, Cdn. Soc. of
So0oil Science, J. A. McKeague, 2nd ed.

‘ORWEST SOIL RESEARCH LTD has been accredited by the STANDARDS COUNCIL of CANADA
for specific tests registered with the COUNCIL.

Il N e aEm >
[ %]
=
o
»

Lab Manager:
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ORWEST #6, 2712 - 37 Ave N.E.

ABS Calgary, Alberta T1Y 5L3
Phone: (403) 291-2022

Fax: (403) 291-2021

TO: Public Works Canada DATE SAMPLED:
DATE RECEIVED: 11-Sep-95
ATTN: Michael Nahir DATE REPORTED: 20-Sep-95
LAB FILE#: 95-09-1809

Eureka Landfill

POLYCHLORINATED BIPHENYLS IN SOIL

EDMONTON WO# 103006 1 2 3 4

LAB # R6963 R6964 R6965 R6966 Detection
CLIENT # EU-1 EU-2 EU-3 EU-4 Limit
PCB Content <0.1 <0.1 <01 <0.1 1

Aroclor Type —

Surrogate Recovery % 99 94 105 103
Decachlorobiphenyl

Results expressed in mg/kg dry wt. (ppm)



#6, 2712 - 37 Ave N.E.
Calgary, Alberta T1Y 5L3
Phone: (403) 291-2022
Fax: (403)291-2021

TO: Public Works Canada

ATTN: Michael Nahir

DATE SAMPLED:

DATE RECEIVED: 11-Sep-95
DATE REPORTED: 20-Sep-95
LAB FILE#: 95-09-1809

Eureka Landfill

Page 2

POLYCHLORINATED BIPHENYLS IN SOIL
EDMONTON WO# 103006 5 6 7 8
LAB # R6967 R6968 R6969 R6970 Detection
CLIENT # EU-5 EU-6 EU-7 EU-8 Limit
PCB Content <0.1 <0.1 <0.1 <0.1 1
Aroclor Type
Surrogate Recovery % 86 99 96 98

Decachlorobiphenyl

Results expressed in mg/kg dry wt. (ppm) _




II:IORWEST #6,2712-37 Ave NE
Calgary, Alberta T1Y 5L3
ABS Phone: (403) 291-2022
Fax: (403) 291-2021
TO: Public Works Canada DATE SAMPLED:

ATTN: Michael Nahir

DATE RECEIVED: 11-Sep-95
DATE REPORTED: 20-Sep-95
LAB FILE#: 95-09-1809

Eureka Landfill

EDMONTON WO# 103006
LAB #
CLIENT #

PCB Content

Aroclor Type

Surrogate Recovery %
Decachlorobiphenyl

Page 3
POLYCHLORINATED BIPHENYLS IN SOIL
9 10 1 12
R6971 R6972 R6973 R6974 Detection
EU-9 EU-10 EU-11 EU-12 Limit
<0.1 <0.1 <0.1 <0.1 1
103 102 103 105

Resuits expressed in mg/kg dry wt. (ppm)
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NORWEST
LABS

#6, 2712 - 37 Ave N.E.
Calgary, Alberta T1Y 5L3
Phone: (403) 291-2022
Fax: (403)291-2021

TO: Public Works Canada

ATTN: Michael Nahir

DATE SAMPLED:

DATE RECEIVED: 11-Sep-95
DATE REPORTED: 20-Sep-95
LAB FILE#: 95-09-1809

Eureka Landfill

'

EDMONTON WO# 103006
LAB #
CLIENT #

PCB Content

Aroclor Type

Surrogate Recovery %
Decachlorobiphenyl

Page 4
POLYCHLORINATED BIPHENYLS IN SOIL
13 14 15 16
R6975 R6976 R6977 R6978 Detection
EU-13 EU-14 EU-15 EU-16 Limit
<0.1 <0.1 <0.1 <0.1 1
103 101 100 106

Results expressed in mg/kg dry wt. (ppm)_



NORWEST
LABS

#6, 2712 - 37 Ave N.E.
Calgary, Alberta T1Y 5L3
Phone: (403) 291-2022
Fax: (403) 291-2021

TO: Public Works Canada

ATTN: Michael Nahir

DATE SAMPLED:

DATE RECEIVED: 11-Sep-95
DATE REPORTED: 20-Sep-95
LAB FILE#: 95-09-1809

Eureka Landfill

EDMONTON WO# 103006
LAB #
CLIENT #

PCB Content
Aroclor Type

Surrogate Recovery %
Decachlorobiphenyl

Page 5
POLYCHLORINATED BIPHENYLS IN SOIL
17 18 19 20
R6979 R6980 R6981 R6982 Detection
EU-17 EU-18 EU-19 EU-20 Limit
<0.1 <0.1 <01 <0.1 1
78 83 90 88

Resuilts expressed in mg/kg dry wt. (ppm)




NORWEST

#6 2712 - 37 Ave N.E.
L ABS Calgary, Alberta T1Y 5.3
Phone: (403) 291-2022
Fax: (403) 291-2021
TO: Public Works Canada DATE SAMPLED:

ATTN: Michael Nahir

DATE RECEIVED: 11-Sep-95
DATE REPORTED: 20-Sep-95
LAB FILE#: 95-09-1809

Eureka Landfill

EDMONTON WO# 103006
LAB #
CLIENT #

PCB Content

Aroclor Type

Surrogate Recovery %
Decachlorobiphenyl

POLYCHLORINATED BIPHENYLS IN SOIL

21 22
R6983 R6984
EU-21 EU-22

<0.1 <0.1

84 86

Results expressed in mg/kg dry wt. (ppm) _

23
R6985
EU-23

<0.1

89

Page 6
24
R6986 Detection
EU-24 Limit
<0.1 1
89
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NORWEST 46, 2712 - 37 Ave N.E.
L ABS Calgary, Alberta T1Y 5L3

Phone: (403) 291-2022
Fax: (403) 291-2021

TO: Public Works Canada DATE SAMPLED:
DATE RECEIVED: 11-Sep-95
ATTN: Michael Nahir DATE REPORTED: 20-Sep-95
LAB FILE#: 95-09-1809
Eureka Landfill
Page 7
POLYCHLORINATED BIPHENYLS IN SOIL
EDMONTON WO# 103006 25
LAB # R6987 Detection
CLIENT # EU-25 Limit
PCB Content <01 1

Aroclor Type -

Surrogate Recovery % 89
Decachlorobiphenyl

WA

Corbet M.Sc., P.Ag.

Manager - Organics

Results expressed in mg/kg dry wt. (ppm)



NORWEST #6, 2712 - 37 Ave N.E,
L ABS Calgary, Alberta T1Y 503

Phone: (403) 291-2022
Fax: (403) 291-2021

TO: Public Works Canada DATE SAMPLED:
DATE RECEIVED: 11-Sep-95
ATTN: Michael Nahir DATE REPORTED: 20-Sep-95
LAB FILE#: 95-09-1809

Eureka Landfill

Page 8

POLYCHLORINATED BIPHENYLS
QA/QC Data Sheet
Calibration Check (CC)

Actual Detected %
Amt. (ng) Amt. (ng) Rec.
Aroclor 1.00 1.037 103.7

1254

Accuracy = Ave % Rec. MS + Ave % Rec. MSD
2

101.7 % Accuracy

% RSD = Ave % Rec. MS - Ave % Rec. MSD
% Accuracy

20 %RSD

The calculated values are based on matrix spike and duplicate recovery
data performed on your samples at the time of analysis.

Date Acquired: September 18, 1995 Analyst: Trevor Ahistrom




938-67 Avenue
Edmonton,AB NORWEST paTe 17 MAY 95 10:14
T6E OPS
P.0. NO.
(403) 438-5522 or 1-800-661-7645
(403) 438-0396 fax w.o.No. 2 97938
PUBLIC WORKS CANADA MICHAEL NAHIR PaGE 1
1000, 9700 JASPER AVE EUREKA
EDMONTON, AB
T5J 4E2

SAMPLE L 2 3
#1 EUREKA #2 EUREKA #3 EUREKA
LANDFILL LANDFILL BATTERY SITE
BACKGROUND BACKGROUND BATTERY STORAGE
AREA

| SOIL HYDRIDE |

ANTIMONY ug/gm 0.10 0.08 0.06
ARSENIC ug/gm 7.34 9.26 8.77
. SELENTUM ug/gm 0.05 0.09 0.33
SOIL COLD VAPOR l
l MERCURY ug/gm 0.02 0.03 0.04
ICP METALS, 3050 |
l SARTIUM ug/gm 43.7 45 68.8
BERYLLIUM ug/gm 0.3 .3 0.6
CADMIUM ug/gm <0.3 <0.3 <0.3
' CHROMIUM ug/gm 15.5 15.4 24.1
COBALT ug/gm 5 6 9
COPPER ug/gm 8.8 10.2 18.4
LEAD ug/gm 3 3 6
MOLYBDENUM ug/gm <2 <2 <2
NICKEL ug/gm 13 14 21
SILVER ug/gm <5 <5 <5
' THALLIUM ug,/gm <3 <3 <3
TIN ug/gm <5 <5 <5
VANADIUM ug/gm 26.9 26.4 37.0
. ZINC ug/gm 35.7 35.4 56.8
| GFAR METALS 3050 ]
. THALLIUM ug/gm <0.30 <0.30 <0.30
HOT WATER BORON |
' BORON ug/gm 1.8 3.4
| PHYSICAL ]
l MOIST.WET WT. % 15.5 14.4 10.3
' Lab Manager: \j‘ﬁ\/



.9938—6'1 Avenue
Edmonton,AB NORWEST DATE 17 MAY 95 10:14

T6E OP5
) 22 or 1-800-661-7645
' (403) 438-0396 fax wo.No. 2 97938
PUBLIC WORKS CANADA MICHAEL NAHIR PAGE 2
I 1000, 9700 JASPER AVE EUREKA
EDMONTON, AB
T5J 4E2

lThe following published METHODS OF ANALYSIS were used:

NWL 6836 ARSENIC EPA6010 VANADIUM
Nitric/perchloric acid digest. Analysis ICP Spectroscopy. Ref. EPA 6010 (SW-846)
by continuous hydride atomic absoption. EPA6010 ZINC
Ref. APHA 3114 C ICP Spectroscopy. Ref. EPA 6010 (SW-846)
NWL6835 MERCURY MSS 4.6 BORON
l Digestion in a hotblock with sulphuric/
nitric acid & vanadium pentoxide.
Analysis by continuous flow cold vapor
atomic absorption spectrometry.
' Ref .Knechtel & Conn, WWTC, Env.Can.
EPA6010 BARIUM
ICP Spectroscopy. Ref. EPA 6010 (SW-846)
l EPA6010 BERYLLIUM
ICP Spectroscopy. Ref. EPA 6010 (SW-846)
EPA6010 CADMIUM
. ICP Spectroscopy. Ref. EPA 6010 (SW-846)
~cA6010 CHROMIUM
ICP Spectroscopy. Ref. EPA 6010 (SW-846)
EPA6010 COBALT
i ICP Spectroscopy. Ref. EPA 6010 (SW-846)
EPA6010 COPPER
ICP Spectroscopy. Ref. EPA 6010 (SW-846)
lEPAGOlO LEAD . :
ICP Spectroscopy. Ref. EPA 6010 (SW-846)
EPA6010 MOLYBDENUM
ICP Spectroscopy. Ref. EPA 6010 (SW-846)
I EPA6010 NICKEL
ICP Spectroscopy. Ref. EP2A 6010 (SW-846)
EPA6010 SILVER
l ICP Spectroscopy. Ref. EPA 6010 (SW-846)
EPAG6010 THALLIUM
ICP Spectroscopy. Ref. EPA 6010 (SW-846)
'Method References:
1. APHA Standard Methods for the Examination of Water and Wastewater,
American Public Health Assoc., 17th ed.
2. EPA a. Test Methods for Evaluating Solid Waste, Physical/Chemical
' Methods SW-846, 3xrd ed., US EPA, 1986
b. Methods for Chemical Analysis of Water and Wastewater, US EPA, 1983
3. Manual on Soil Sampling and Methods of Analysis, Cdn. Soc. of
I Soil Science, J. A. McKeague, 2nd ed.

‘ORWEST SOIL RESEARCH LTD has been accredited by the STANDARDS COUNCIL of CANADA
for specific tests registered with the COUNCIL.

Lab Manager:
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o NORWEST DATE 16 NOV 95 156:04
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PUBLIG WORKS CANADA | © MICHAEL NAHIR Pace 3
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1000, 9700 JASPER AVE - | 09 09 95
l EDMONTON, AB
T5J 4E2 |

SRR

& L
g%g%.,'#

___PARTICLE STZE __ . SOIL COL SOIL COL
HYDROMETER -

l saxp  SILT  CTAY aiiant By Mg
e CLASS , -
o emoooSRMPLE DESCRIPTION % % LI o ' ‘ ng/kg ng/ kg
ll 1 EU-1 ; ' ] 0.06
2 EU-2 0.06
3 EU-3 0_06
. 4 EU-4 0.08
v 5 EU-5 0.06
¢ EU-6 0.06
I 7 EU=7 0.06
. 8§ EU-B 0.06
8 EU-9 0.05
, 10 EU-10 . ; : 0.05
' 11 EU-11 18.0 47.0 35.0 si.c.LoMm - - 0.06
e 12 EU-J.Z . T o : R - T o . 0.06
13 EU-13

14 EU-14

15 EBU-15

16 EU-16

17 EO-17

18 EU-18

19 BU-1%

20 EU-20 : ‘ _

21 BU-2L . .

22 :u_‘zz B T A A
123 pU-23

24 BU-24
7 25 EU-25

ANALYSIS PERFORMED ON DRIED AND GROUND SAMPLE.DRYING TEMPERATURE

. *note* MERCURY : -
.. .. .. T0 EXCEED 60 DEGREES CENTIGRADE AS PER EPA 7471

A

B o
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ANNEX C

DATALOGGER PC INFORMATION



LogBook*

for Windows
User’s Guide
Vers. 2.0

Computer Corporation
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LogBook Quick Start

Follow this procedure to quickly get your Hobo or StowAway connected
and displaying data. Detailed installation instructions and descriptions of
all the menu options follow on later pages.

1 Install the LogBook software.

2. Connect the interface cable to Com Port 1 on the back of the

computer.

3. Connect the other end of the interface cable to the logger.

4. Verify and set your computer clock to the correct time and date.
5. Double click on the LogBook icon to start the software.
6
7

. Pull down the Logger menu and select Launch.
. Press the Start button. The logger wiil be launched with default settings and start record-
ing data.

8. Wait a few seconds and pull down the Logger menu and select Readout. The data re-
corded by the logger will be downloaded and displayed on the screen as a plot; you
will be prompted to save the file.

Congratulations - you have completed the installation and verified the operation of your
new logger!

Getting ready

Installing LogBook for Windows on a Hard Drive

To install LogBook software onto your hard drive, insert the LogBook diskette into the
floppy drive of your computer. In the Program Manager, choose Run from the File menu,
type a:\install (or b:\install). It will ask you for the dlrectory (LOGBOOK?2 is the default)
and install the program and the help file.

Connecting to Your IBM Compatible

The logger is connected to your computer with an interface cable. The PC-3.5 cable is de-
signed to connect directly between the IBM Compatible’s DB-9 serial port and the data log-
ger. A DB-25 to DB-9 adapter may be needed if your computer does not have an available
DB-9 port.

Before Starting LogBook

Before starting LogBook make sure your computer’s clock is set to the right time because
the HOBO or StowAway will use your computer’s clock setting to initiate its own internal
clock setting. If you are using a HOBO-TEMP or StowAway TEMP with an external ther-
mistor probe, this would be a good time to plug that probe in.

Starting LogBook

To start LogBook for Windows, double click on the LogBook icon.



Current

LogBook causes the logger to make a measurement every second while the Launch Dialog box
is open. Current shows the most recent reading from the logger displayed using the unit speci-

fied by ‘Measure’.

Legend

The text in the Legend box is displayed below the time axis at read out. Up to 40 characters can

be written in this area.

HOBO-TEMP {C) 1992 ONSET -37C TO 45C S/N 13122

Duration: 2 Hrs=30 Mine #| Intervai: 5Sec

Measure: ITemperalure (*F) L&_J Current: 73.99

Legend: [Te:t

O Wrap around when full (overwrite oldest data)

l : Cancel ] [ - Start ~l

Launch Dialog Box for Hobo Loggers

Start

Wrap around

When “Wrap around when
full” is checked, the logger
will not stop when it is filled,
but instead will overwrite the
oldest data with new measure-
ments. If you launch with a 30
day duration, but do not re- -
cover the logger untii much
later, the data will reflect the
last 30 days. When “Wrap
around when full” is not
checked, the logger will turn
itself off when it is full, and
await recovery and read out.

Click the Start button when you are satisfied with the current settings. LogBook will load this in-
formation in the logger and start it. Do not unplug the logger from the interface cable until Log-
book has indicated that the launch has been completed. You can confirm that the logger has been
launched by looking at'the logger’s status LED which will continue to blink at least once every

two seconds after it has been launched.

Cancel

Press the Cancel button if you decide not to launch the logger. The old settings and the data in the

logger will be preserved.



EE Triggered Start I

<] Delayed: DD HH:MM:SS

{00 00:00:00

Eglalm:
3836 [+ e
27.90 [+ ] [+]

X Multiple Sampling:
@® Ayerage
C Minimum
O Maximum

Delay after Triggered Start

Selecting both Triggered Start and Delayed causes the
StowAway to delay this amount of time after the trigger
has been activated; before it starts logging. Enter this de-
lay in the format DD HH:MM:SS.

Alarm

Alarm, when selected, allows you to see if the StowAway
has recorded a reading outside of a selectable range. The
alarm reads in the units shown in the Measure box. To set
the Alarm, select the alarm box and move the tabs to the
dasired values. The various StowAway loggers have dif-
ferent ways of representing alarm conditions, read the in-
dividual loggers manual for details.

Multiple Sampling

When Multiple Sampling is not selected, the logger mea-
sures and stores a single measurement during each mea-
surement interval. Multiple Sampling causes the logger
to make multiple measurements during an interval and
store the minimum, maximum, or average of the readings,
as selected by this box. In multiple sampling mode the
logger takes about 100 measurements evenly spaced in
each interval unless the interval is less than a minute. For
shorter intervals the logger will measure once every half
second during the interval. :

Multiple sampling increases the average current drain of
the logger. To minimize current drain this feature should
not be used unless needed.



Zooming in on any Plot Section
You can zoom in on any section of the plot by
using the Selection tool to draw a box around
the section of interest. To Zoom, either click
inside the box and select Zoom Selection on
the View menu or press F7. If you are using NE
the Zoom tool (magnifying glass cursor), you b
can use the left mouse button to zoominona
selection without clicking inside the box first, and
the right mouse button can then be used to zoom
back out.

Zooming Out =
You can zoom out to the previous plot by choosing
Zoom Out on the View menu or by pressing F8.

Returning to the Original Plot View
To return to the original plot of your data, choose

¥ N 2 M
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w
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OROD  'EOD O3hAX) OROD  1G00 DM  GRED 160D Ol OROO
Sl on P - § <A

Original Plot from the View menu or by pressing F9. Zooming in on a Plot
. . =i trip.dif
Flle lnfOrmcﬂon StowAwav-TEMP ONSET Inst.-36C TO 46C
The File Information selection from the SIN 4806 Points: 1255
View menu opens a box that describes the Trip
currently displayed file. The description is Start: 09Dec94 15:00:00.0
for the entire file and does not change with End: 11Dec94 17:09:36.0
a zoom. Min: 26.05 Max: 72.01 Temperature [*F)

File Information Dialog Box

Printing your Graph

To Print the plot of your data, select Print... under the File menu. Plots can be resized on the
screen but this will not affect the printed size. Plots will be scaled to nearly fit a full page, ei-
ther in landscape or portrait mode. Plot scaling is not available.

Print Setup

Selecting Print Setup from the File menu displays the Print Setup dialog box. From here you
can choose the page orientation: Portrait or Landscape. Additional options may be available de-
pending on the attached printer.




View Readout Log

LogBook will create an entry in the
Readout Log for each saved file with
the information: file name, serial num-
ber, header information, start and end
date/time, and number of points. You
can use View Readout Log under the

| File: I

Open... Ctri+0
Close

Save As...
Export Setup...
Export Plot Data...

Print... Ctrl+P
Print Setup...

File menu to view the text file using
X . Preferences...
NotePad. It can also be viewed using - Aead .
any other text editor. View. Readout Log:
Exit Alt+F4
= e rvnie i fiamae = Nolepad - READOUT.LOG =~ ous mmngsestivssest el
Eile Edit Search Heip :
File S/N Legend Text Start Time End Time SofPoints Shuttle S/N |X
c:\logbook2\water_st.dtf
i 92 water stream river lake pond 10Mar9s 01:27:k%1 10Mar9s 01:27:41 ]
c:\logbook2\altitude.dtf
234 Altitude (fFt) 28Feb95 13:01:20 28Feb95 14:01:18 1800
c:\logbook2\water_st2.dtf
92 water stream river lake pond 10Mar9s 02:37:41 10Mar9s 02:37:57 16
c:\logbook2\check.dtf N
305 Uoltage (V) 01Mar9s 10:35:57  014ar9S 18:346:09 26 .
c:\logbook2\default_.dtf :
20 DEFAULT LAUNCH HERDER 22Jun79 16:32:06 22Jun7?? 16:46:05 1680 255 |-
c:\logbook2\a_test_.dtf
97 A Test . 87Mar9s 16:39:54%  08Mar9S 03:41:49 7948 11:
[+
1) ! - e = TS s L PR AV R0 ;[0

Readout Log Window




Export Current Display Units Only
Export normally provides separate columns for each unit available for displaying the data. With
this box checked, only one data column is created, containing the units used in the plot currently

selected.

Exporting the Data

To export a file with LogBook, first open an existing file or read out a new file. Next, choose
Export Plot Data from the File menu. LogBook will then ask you to Save the file with the ex-
tension .TXT. The data will then be exported in the format last specified by the Export Setup dia-

log.
NOTE: Exported files cannot be read back into LogBook.

Working with an Exported File

To work with an exported file, start the intended program, e.g., Lotus 1-2-3, Excel, or Quattro
Pro, and then import or open the file that was saved with the .TXT extension. If you are having
problems finding the file which was saved, please refer to the User’s Guide which came with
your computer. This will allow you to work with your data inside the spreadsheet.

Multiple File Export

Some spreadsheets are not able to import files with more than 16,000 points. So, when you try
to export a file that contains 16,000 points or more, LogBook will ask you if you wish to sepa-
rate the data into more than one file. If you choose yes, a dialog will appear telling you the num-
ber of points in the file and will ask you to specify the number of points per file. Once you
choose the number of points, it will prompt you to select a file name. All the files will be saved
with this name with a number appended to the end.

Muitiple File Export:

StowAway-TEMP ONSET Inst.-36C TO 46C S/N 1919
Number of Data Points: 32520

Number of Points Per File:

Multiple File Export Dialog




The Tool Bar
== E e Al

The buttons on the Tool Bar allow quick access to some of the functions. The Message Bar at the
bottom of the window describes these when the pointer is placed on them.

Tool Bar Button Descriptions
(from left to right)

Open: Allows you to plot previously off-loaded LogBook compatible files.
Save As: Saves the currently displayed file using a selectable name.
Print: Allows you to print the currently selected plot.

Copy: Copies the plot as a bitmap to the Clipboard.

Launch: Displays the launch dialog box.

Readout: Reads the data from the logger.

Shuttle Readout: Off-load data files from the Optic Shuttle

Connect Points: Draws a line between each point on the plot.

Mark Points: Displays a smail circle around each data point.

File Information: Displays additional information about the current plot.
Selection Tool: This is the default general purpose selection cursor.
Zoom Tool : Allows you to select an area of a plot and magnify it.

Help: Brings you to the contents of the help file.

Copying Pictures

IE: | Ii To copy your graph as a bitmap to the Clipboard, select Copy from the

ffn-a iris7 Edit Menu or use the button on the toolbar. To copy iust a section of
""" S = you graph, use the Selection tool to select the area of interest and then
B Trriand select Copy.

Qoby Ctri+C

v g .3
S Eytaa 3 dg L5
S G £ \4U§+1

= NOTE: The Undo, Cut and Paste functions are not currently available.
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Commonly Asked Questions @D

&. When selecting Launch or Readout, the software gives the message “Can't connect to data
logger.” What's wrong?

A. This is probably a serial port problem:
1. Make sure that the interface cable is pressed all the way into the jack on the Logger.

2. Make sure that the interface cable is connected to a working serial port. If the se-
rial port was recently used for a network or a mouse, the port may still be configured
as such. When removing a mouse, reboot your system.

Q. Can a Logger that has been launched with one version of LogBook be read out by
LogBook 2.0?

A. Yes!!

&. When I use the Excel or Lotus time format to export the data, there are large decimal
numbers in the first column, for example: 34436.4687037. What are these numbers?

A. Spreadsheet programs use numbers called ‘serial numbers’ to represent dates and
times. These need to be reformatted into a readable form. The part to the left of the
decimal point is the number of days from some date in the past, often January 1,
1900, and the fractional part represents the fraction of a day thereafter. In order to
format this column please see the section on Export Setup.

&. My spreadsheet program allows either MM-DD-YY or HH:MM_:SS for the possible
time and date formats. What can I do to get both date and time?

A. Use the insert command in your spreadsheet program to insert a new column in the
spreadsheet. Copy the column containing the time serial numbers to the column you
have inserted. Use the formatting commands on your spreadsheet to format one as
date: MM-DD-YY, and one as time: HH:MM:SS.
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Keyboard Shortcut Table

Action

Keys 1o Press

Open

Ctrl+O

Print

Ctrl+P

Exit

Alt+F4

Copy

Ctrl+C

Launch

Ctri+L

Readout

Ctri+R

Connect Points

F4

Mark Points

F6

Zoom Selection

F7

Zoom QOut

F8

Original Plot View

F9

Help

F1
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Onset Computer 2-2-95 D-RWK-00091-C
Gerneral Notes on using Onset Subcase Page 1 of 2

The Onset ‘SUBCASE’ products were originally designed by lIkelite and are now produced
for Onset on a special order basis. They provide generally reliable water tight solutions at a low
cost for most applications. However, because each use of a case requires making a new seal,
Onset can not guarantee that yours will not legk. In fact, they are not tested before resale. After
more than a year of customer experience, we have found field failures to be rare and in nearly all
cases, failure could have been avoided. Pleass read these notes on the use and care of the
following products;

SUBCASE-WH general purpose white submersible case
SUBCASE-CLR general purpose clear submersible case
SUBCASE-A white submersible case with thermistor potted to inside surface

Onset specifies the cases for use in dry air where the temperature remains between -50°C
and +120°C or in humid air or fresh or salt water where the temperature remains between -50°C
and +60°C. They should not be placed more than 400 feet below the water's surface. Steam
baths or autoclaves will cause the case to become brittle and crack.

Onset does not recommend the cases for eny other environment. They are made from
colycarbonate and can be adversely affected by certain combinations of chemical expesure,
heat and pressure. Use only O-rings and lubricants provided by Onset. Failures from exposure
to various chemicals range from immediate crumbling to gradual crazing. Use only mild soap
solutions to clean the cases. The following chemical classes are known to adversely effect
polycarbonate; amines, aromatic hydrocarbons, halogenated hydrocarbons, esters, ketones and
high concentrations of acid, alcohols, or alkalis. While petroleum and silicone greases and oils
are safe, common additives to them are not.

Before using your submersible case, inspect the area where the o-ring will be placed. Make
sure the surface is clean and there are no cracks. The surface will not be perfectly smooth, that
is normal.

When placing your Hobo or Stowaway in the case, note that the fit is very snug. Do not force
the logger all the way to the botiom or it will be difficult to remove later. Place a desiccant pack in
the case with your Hobo or Stowaway. Warm air holds more moisture than cool air. If your case
gets colder, water may condense out of the enclosed air and can cause corrosion of your data
logger or possibly stop it from running. Color coded desiccant packs can be purchased from
Onset. When they are dry and zble to absorb moisture they will be blue. As they become
Saturated, they turn pink. If the desiccant is white or clear, it is nct color coded.



	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	


